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REPORTING REQUIREMENTS

The Department is afforded authority by Section 324.0221(1)(a) (Florida Motor Vehicle No-Fault Law),
Florida Statutes, to develop procedures, rules and regulations to create and maintain an automobile
insurance reporting database (insurance file).
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The purpose of this manual is to set forth the procedures to accommodate insurance company reporting
and department processing of reported data.

Section 324.0221(1) (a), Florida Statutes, reads in part:

“Each insurer that has issued a policy providing personal injury protection coverage or property
damage liability coverage shall report the cancellation or nonrenewal thereof to the department
within 10 days after the processing date or effective date of each cancellation or nonrenewal.
Upon the issuance of a policy providing personal injury protection coverage or property damage
liability coverage to a named insured not previously insured by the insurer during that calendar
year, the insurer shall report the issuance of the new policy to the department within 10 days.
The report shall be in the form and format and contain any information required by the
department and must be provided in a format that is compatible with the data processing
capabilities of the department. Failure by an insurer to file proper reports with the department
as required by this subsection constitutes a violation of the Florida Insurance Code. These
records shall be used by the department only for enforcement and regulatory purposes,
including the generation by the department of data regarding compliance by owners of motor
vehicles with the requirements for financial responsibility coverage.”

INTRODUCTION

The following are the specifications for insurance companies to use to Report Records as
defined herein to the Department. This manual is predominantly specific to the XML coding. In
the future, the latest version of the XML schema and XSD files will be located on our FR
Website, http://www.flhsmv.gov/IFRManualFTP/. The XML schema is what you will use to create
your files that you send us. There is a schema version number located in the XML file, the file
that you send to us needs to include that same schema version number in order for your file to
be processed. The XSD file is used for validation. There are a number of free tools on the
Internet that use this file to validate the XML file that you created. If a modification needs to be
made to the XML schema, the insurance companies will be notified at least 90 days in advance.
Flat files submitted for Reloads and Daily submissions will be accepted and returned in the flat
file format until further notice. The anticipated deadline for completion of reloads and
transferring to XML is September 2013.

DOCUMENT CONVENTIONS

e DHSMV — Department of Highway Safety and Motor Vehicles

o XML file — XML is an acronym for Extensible Markup Language. XML is a universal format
for structured documents and data on the web.

e SFTP- SFTP is an acronym for Secure File Transfer Program. SFTP is used to securely
transfer files between the insurance companies and the DHSMV.

e SFTP Site — The SFTP site is the web address that the user goes to transfer files.

e Encryption — The process of transforming information to make it unreadable to anyone
except those possessing the key.
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http://www.flhsmv.gov/FRManualFTP/

o Decryption — The process of decoding data that has been encrypted to make it readable by
using the specific key.

e Public key — The key used either by the insurance company or DHSMV to lock or encrypt
the XML files before transfer.

o Private key — The key used either by the insurance company or DHSMV to unlock or decrypt
the XML files after transfer.

e FEID - Federal Tax ID, also known as Federal Employer Identification Number (FEIN).

RELOAD OVERVIEW

Insurance companies will be able to place files into individual company folders throughout the
day by using their username/password to log onto the SFTP site. For a reload or daily reporting,
you may include multiple company codes in one reload/daily file. All files will need to be
encrypted using DHSMV’s public key before being placed on the SFTP site. There are six
folders used for uploading and storing files:

1. The “Test” folder will be used when the insurance company wants to submit a file for test
purposes only. . The test files will be picked up at 9:30a and 6pm Monday thru Friday.
Please begin all reload tests with ‘Reload_’ and all daily tests must begin with
‘DailyLoad_’. If your test files do not begin appropriately, they will not be picked up and
processed by our system.

Example Reload Test File: Reload_testfile.pgp
Example Daily Test File: Dailyload_testfile.pgp

2. The “Reload” folder will be used when the insurance company wants to perform a
complete reload of only their active policies. Files will be processed on Wednesday and
Friday mornings starting at 12:30am. Files will also be processed through the weekend,
starting Saturday at 10pm and run through Monday morning around 5am.

3. The “Dailyload” folder is used to update DHSMV information regarding changes to your
policies and is processed at 8:30a Monday thru Friday. Before sending a Reload file,
you will need to suspend your regular daily files from uploading. Bulk policy corrections
should be sent in your Dailyload Folder and then once the reload is updated you can
resume your daily filing to this folder.

4. The “Output” folder is used by DHSMV to inform the insurance company of the file
transfer results, you may delete the file after you retrieve it or leave it in this folder. All
files will be marked with the date and timestamp for easier retrieval.

e The return file name will be: (YourFilename)B(TimeStamp).pgp for flat
files
DHS.DDL.FTP.DMIXXXXB03_15 2013_10 37 38.PGP

e The return file name will be:
YourFileName_TimeStamp_DL_TransactionReport.pgp for XML files
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5. The “Archive” folder is where the files placed by the insurance companies are moved
after they have been processed. You will have access to this folder, however, please do
not delete from this folder. Files over 90 days will be deleted.

6. The “Verifications” folder is where DHSMV places all verification file request and are
required to be retrieved daily by your insurance company for review and response. The
verification records within the file should be returned in your daily reporting file within
20 days. Any verification records not responded to will be requested again with the
‘Days Late’ field populated. The verification file name will be:
(Verifications)(TimeStamp).pgp. Any records not responded to will be resent every 30
days until responded to with one of the following message:

o Confirmed and Active (confirmed on the need date and still active with
continuous coverage)

¢ Confirmed (confirmed on the need date), or
¢ Unconfirmed (unable to confirm).

You will now potentially receive a C file daily. The verification file name will be:
SR21_Verifications_(Date/TimeStamp).pgp. This file will be in flat format until
total XML conversion.

Until switched entirely to XML, you will still receive you large Monday C file in the
old format: DHS.DDL.FTP.DMIXXXXC(Date/TimeStamp).PGP

Florida Motor Vehicle No-Fault Law FTP Reporting Procedures

PGP Keys

The insurance company must generate two keys. A private key used to decrypt files and a
public key which the Department will use to encrypt files. You may use your existing keys,
otherwise, please contact the Department for needed information about exchanging keys and
encrypting files. IMPORTANT: The files uploaded to the server must be encrypted using
DHSMV’s public key; otherwise, the files will not be processed.

Logging into the SFTP Server
Once the PGP keys have been exchanged, an encrypted file will be sent to the insurance
company containing user name and password information.

Sending and Receiving Files

The encrypted files must be placed on the new server, which uses SFTP protocol and port 22.
The server name is: FTPCEREX.flhsmv.gov. The new server will behave the same as the old
FTP server, so the passwords and PGP keys will remain the same. The usernames will have
one small change, which is a zero (‘0’) was added to the beginning of the username. For
example, if your original username was ‘9332FTP’, it will now be ‘09332FTP’.
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File Specifications

The file name may be called whatever makes sense to the insurance company. After the file is
processed, it is placed in the Archive folder. The transfer results will be placed in the Output
folder.

Error Message Information

XSD Validation

Prior to processing the file, we validate that the XML schema is correct. If there is an issue with
the schema, a text file will be generated and placed in the Output folder. The file name will
follow the following structure: ValidationFailed_Timestamp.pgp.

Policy Errors

These types of errors occur when DHSMV receives information regarding an active policy, but it
is cancelled in the DHSMV database or DHSMV receives information regarding a cancelled
policy, but it is active in DHSMV database. When these errors occur, an output file will be
generated and placed in the Output folder for the insurance companies. There will be two error
files generated if necessary. One file will be for Cancelled policies and the other will be for
Missing policies. The file names will follow the following structure:

YourFileName_TimeStamp_BulkPolicyError_Cancelled.pgp
YourFileName_TimeStamp_BulkPolicyError_Missing.pgp

To resolve the records in the ‘Missing’ file, you will need to submit a 10 (Cancellation) through
the Daily Reporting process or if the policy should be active then a ‘20’ (Initiation) transaction
should be appended to the reload file. To resolve the records in the ‘Cancelled’ file, an 11
(Recall of Cancellation) should be submitted through the Daily Reporting process.

In order to resolve the bulk policy conflicts, the corrections should be made through the ‘Daily
Reporting” process and then the entire reload file should be resubmitted again for processing.

NOTE: As mentioned above, we suggest that you hold your daily submissions when trying to
correct the bulk policy errors. This is to ensure that the daily submissions will not cause more
bulk policy errors when the same reload file is resubmitted. But for some companies, they can
easily pull a brand new reload file, these companies are going to continue submitting daily’s
while fixing their bulk policy errors. Then once they have fixed their bulk policy errors, they will
pull a new reload file and submit it.

Note for flat file reloads:

All lines must be greater than 205 characters.
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If the line length is less than 205 characters, the system will not read the policy number.
Therefore, it is possible you could receive a missing policy in your missing file even
though you supplied the policy in your reload file.

Reload Transaction Report

Once you pass bulk errors, an output file will be generated and placed in the Output folder for
the insurance companies, regardless if any errors occurred. This transaction report is sent once
you have passed the bulk errors and no longer have any missing or cancelled return files. The
transaction report name will follow the following structure:
YourFileName_TimeStamp_RL_TransactionReport.pgp.

This usually contains formatting errors. If no errors occurred, there will be a count of the
number of records imported into the database. If there are no errors in the transaction report,
you have passed your reload. Feel free to contact us for confirmation.

Records will be imported into the database, unless the error rate is over 5%. If you are less than
a 5% error rate tolerance, your reload will be accepted and loaded into production. Feel free to
contact us at this point for confirmation. For files with errors under the 5% tolerance rate, once
those records have been corrected by the insurance company, they can be resubmitted in a
Daily Reporting file. There is no need to resubmit your reload (until the next year). Once you
are under 5% tolerance, you should still try to correct all errors.

If there were errors because of data within the file not formatted correctly, only the records with
errors will appear in the transaction report. If the error tolerance rate is over 5%, then none of
the transactions will be imported. If you do not fall within the 5%, you should correct errors and
resubmit your reload. Repeat the process until no errors or under 5% tolerance. Once you are
under 5% tolerance, you should still try to correct all errors.

Note: You must fall within a 5% tolerance level on the transaction report to have your
reload accepted and loaded into the database. Also, this must be ran in production for it
to be accepted. We will not load reloads from a test into our production database.

The current output file will show:

e The number of records submitted

e The number of records that DHSMV has imported (only imported if no errors or under
5% tolerance)

e The number of records that were not imported

Corrections should be made through the ‘Daily Reporting” process to resolve the transaction
errors.

Transaction Error Codes and Error Messages:
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Below are the transaction error codes and error messages. In parenthesis, is information regarding if

the record will still be imported when the error is received.

001 - VIN not registered with FL DHSMV. HSMV will attempt to validate the VIN, as
registered, again in 30 days(will import)

002 — Partial 15 digit match on VIN(will import)

003 — Unable to locate single VIN match; multiple partial matches found (will not import)
004 - VIN is not valid (will not import)

005 — VIN must be 17 characters for a vehicle year greater than 1980 (will not import)
006 — VIN is required for non-fleet policies (will not import)

007 — Company code is not registered with FL DHSMV (will not import)

008 — Company code must be 5 digits (will not import)

009 — Transaction type is not valid for reloads, transaction type must be set to ‘20’, ‘371’
or ‘34’ (will not import)

010 - Reload policy is cancelled on database (will not import)

011 - Policy is currently cancelled (will not import)

012 - Vehicle Effective Date is required on '31' transaction types (will not import)

013 — Policy Through/Cancellation Date cannot be prior to Policy Effective Date (will not
import)

014 — Through Date must be a valid date (MMDDCCYY) (will not import)

015 - Found active policy on the database with an Effective Date after the submitted
effective date (will import)

017 — Level of Coverage is not in the correct format (will not import)

018 — VIN contains invalid characters (will not import)

019 — Policyholder first name contains invalid characters (will not import)

020 — Active policy not found on reload (will not import)

021 — Policy is currently cancelled and needs to be recalled (will not import)

022 - Cannot recall cancelation, policy is currently active (will not import)

023 - Policyholder last name contains invalid characters (will not import)

024 — Vehicle Effective Date cannot be in the future (will not import)

025 — Vehicle Effective Date must be a valid date (MMDDCCYY) (will not import)

026 - Recall of cancellation date cannot be prior to the cancellation date (will not import)
027 — 30 Day Notice: Second attempt to validate the VIN, as registered, has not been
successful (will not import)

028 — Last attempt to validate the VIN, as registered, was unsuccessful; the record will
be removed from our database. Please verify the VIN and resubmit the updated
information through a Daily Reporting (will not import)

029 - Policy number contains invalid characters (will not import)

030 — On areload, cannot submit a transaction type ‘31" without submitting a '20" (will
not import)

031 — Cannot recall initiation of insurance, policy is currently cancelled (will not import)
032 — The recall of initiation date is 90 days after the policy effective date (will not
import)
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¢ 033 —On an Initiation at least one vehicle is required (will not import)

e 034 — Vehicle already exists on policy (will not import)

e 036 — On areload, cannot submit a transaction type '34' without submitting a '20" (will
not import)

e 037 — Policyholder Effective Date must be a valid date (MMDDCCYY) (will not import)

e 038 — Policyholder Effective Date is required on '34' transaction types (will not import)

¢ 039 — Policyholder effective date cannot be in the future (will not import)

¢ 040 — Company indicator is invalid, please choose 'C' or leave blank (will not import)

e 041 - Fleet indicator is invalid, please choose 'F' or leave blank (will not import)

e 042 — Vehicle Make is required (will not import)

¢ 043 — Vehicle exists on multiple active policies (will not import)

e 044 — Vehicle does not exist on the policy (will not import)

e 045 - Driver does not exist on the policy (will not import)

e 046 — Driver already exists on the policy (will not import)

o 047 — Policy already exists in our database (will not import)

e 048 — Cannot update policy, Driver's name does not match (will not import)

e 049 — Cannot add driver or vehicle, initiation record had an error (will not import)

e 050 — Initiation of Insurance is not present (will not import)

¢ 051 — Cancellation updated, policy was already cancelled (will import)

e 052 - Invalid Transaction Type (will not import)

e 053 — Cancellation processed. Driver’s license number supplied was invalid (will import)

o 054 — Cannot delete driver from the policy, only one driver currently exists (will not
import)

e 056 — VIN does not exist on the policy (will not import)

e 057 — VIN is required when updating the Level of Coverage (will not import)

o 059 — SR22 not required, no open FR Suspensions exist for the DLN provided (will not
import)

e 060 — Certification Date must be a valid date (MMDDCCYY) (will not import)

e 061 - Prepared Date must be a valid date (MMDDCCYY) (will not import)

e 062 — Duplicate SR22/26 or SR33/36 or FR44/46 found (will not import)

e 063 — Case is older than 3 years, a SR/FR Certificate is no longer needed (will not
import)

e 064 — A newer SR/FR Certificate has been found (will not import)

e 065 — No matching SR/FR Certificate could be found when attempting to process the
cancellation (will not import)

o 066 — Level of Coverage insufficient, must have at least a '04' Level of Coverage (will not

import)

e 067 — Level of Coverage insufficient, must have at least a '05' Level of Coverage (will not
import)

e 068 — Level of Coverage insufficient, must have at least a '06' Level of Coverage (will not
import)
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o 069 — Level of Coverage insufficient, Level of Coverage must be set to '08' (will not
import)

e 070- Multiple Offender - Not sent to insurance company (will import; in house only)

e 071 —When responding to verifications, the values for ' CONFIRMED AND ACTIVE',
'CONFIRMED' or 'UNCONFIRMED' must be set to either "Y' or 'N' (will not import)

o 072 —When responding to verifications, only one of these fields can be set to 'Y’, the
others need to be set to ‘N': 'CONFIRMED AND ACTIVE', 'CONFIRMED' or
'UNCONFIRMED' (will not import)

e 073 — Currently, we are not accepting this transaction type in XML format. Please
resubmit this transaction in a 350 character flat file (will not import)

e 074 — Confirmed flag must be a 'Y or N (will not import)

e 075 — Verification Not Requested or Already Received (will not import)

e (076 — Cancellation Date cannot be more than 45 days in the future for a Commercial
policy (will not import)

e 077 — Cancellation Date cannot be in the future for a Non-Commercial policy (will not
import)

e (078 - Effective Date Cannot be prior to current effective date (will not import)

o 049 — Cannot add driver or vehicle, initiation record had an error (will not import)

e 00A — Transaction Type contains invalid characters (will not import)

e 00B — Policyholder middle name contains invalid characters (will not import)

e 00C - Vehicle Year not a valid year (will not import)

e 00D - Vehicle Year required when VIN is present (will not import)

e 0OE - Insurance policy number required (will not import)

e OOF - Policyholder first name missing (will import)

¢ 00G - Policyholder last name required (will not import)

e 0O0H - Policyholder state not valid (will not import)

e 00l — Policyholder zip code not valid (will not import)

e 00J - Policyholder zip code not complete (will import)

e 00K - Florida Driver’s License is not in the correct format (will not import DLN, but will
import the record)

e 00L — No matching FL DLN found (will not import DLN, but will import the record)

e 0OM - DLN is not required on Fleet policy (will import)

e OON — Current Driver's License Number Found - (will import)

e 000 — Company FEID is missing (will import)

e 00P — Company FEID must be 9 digits (will import)

e 00Q — No matching FEID number found (will import)

e 0O0OR — Company name is missing (will not import)

e 00S - Company indicator is invalid, please choose Y’ or ‘N’ (will not import)

o 00T - Effective Date must be a valid date (MMDDCCYY) (will not import)

e 00U - Effective Date cannot be in the future (will not import)

e 00V —DOB is not a valid date (MMDDCCYY) (will not import)

e 00W — DOB cannot be in the future (will not import)
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e 00X — Gender must be ‘M’ or ‘F’ or blank (will not import)
e 00Z - Fleet Indicator is invalid, please choose ‘Y’ or ‘N’ (will not import)

For Flat File Reloads:

e Only transaction type ‘20°, ‘31" and ‘34’ will be accepted

e A ‘31 transaction type will not be accepted if a corresponding policy ‘20’ transaction type
iS not submitted.

o A ‘34’ transaction type will not be accepted if a corresponding policy ‘20’ transaction type
is not submitted.

o A1 will appear in position 311 to signify either a transaction type other than 20’ or ‘31°
was submitted or that a ‘31’ or ‘34’ was submitted without a ‘20’

¢ In the scenario where a ‘20’ is submitted and followed by ‘31’ and/or a ‘34, if that ‘20’
fails, then the other related records are also going to fail with the same errors that the
‘20’ encountered. Also, the transaction type for those records will be changed to a ‘20’
so you know it was the ‘20’ that encountered those errors.

e During the Bulk policy validation, if you report multiple 20s to report multiple vehicles or
policy holders and the policy is cancelled on our side, you will see that policy listed in the
Cancellation file one time.

e During format validations, you will get a row back for each transaction that failed. We do
combine the policy transactions in a flat file, but you should still get multiple errors back.

For XML File Reloads:

e Only transaction type ‘20, ‘31’ and ‘34’ will be accepted.

e A ‘31 transaction type will not be accepted if a corresponding policy ‘20’ transaction type
is not submitted. If a ‘31’ is submitted without a ‘20’, the following error will be created:
030 — On areload, cannot submit a transaction type '31" without submitting a '20'

e A ‘31 must be in Vehicle_Transaction_Type the field.

e The Vehicle Effective Date is optional and will be defaulted to the Policy Effective Date if
left blank.

o A ‘34 transaction type will not be accepted if a corresponding policy ‘20’ transaction type
is not submitted. If a ‘34’ is submitted without a ‘20’, the following error will be created:
036 — On a reload, cannot submit a transaction type '34' without submitting a '20'

e A ‘34’ must be in PH_Transaction_Type the field.

o Ina XML file - In a reload, you should be sending one ‘20’ for a policy and that
transaction should contain additional VINs as ‘31’s (as many as needed) or additional
policy holders as ‘34’s (as many as needed). If you send multiple ‘20’s and the policy is
cancelled, each transaction should receive a policy error. If you send one "20 with all the
VINs within that transaction, you will receive only one error back for the policy.
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Holding Errors

This is new functionality that applies to the XML format only. When a VIN is submitted through
a Reload or Daily Reporting file and cannot be located in the HSMV database. The system will
import the record into the Insurance Database and place the VIN in the ‘Holding’ location. The
insurance company will receive a warning message that will be placed in their Output folder on
the server. The VIN will be checked again in 30 days to see if it has been registered with the
DHSMV. If the VIN is still not registered, we will send another file with a warning natification to
the Output folder informing you that the system tried to verify the VIN again and was
unsuccessful. The VIN will remain in the holding location and will be flagged to be checked
again in another 30 days. If the VIN has still not been registered after 60 days, we will send the
final file with an error message to the Output folder notifying you that the final attempt to verify
the VIN was unsuccessful and the record is going to be removed from our database. The
insurance company should verify the VIN with the policy holder and resubmit any changes you
make to the record. At any time, during the three checks, if the VIN is verified, the record will be
imported and you do not have to resubmit. The file name will be for these errors will be
Unregistered_Vins_timestamp_DL_TransactionReport.xml.

Also, when we receive a valid Cancellation (type 10) or a valid Recall of Initiation (type 21), we
will update the database and put the vehicle information in the Holding table to be checked 20
days later. We are checking to ensure the vehicle is insured. The insurance companies will not
need to perform any action after submitting the cancellation.

New Fields for XML File

Level of Coverage

The ‘Level of Coverage’ field is a new, optional field used to describe the level of coverage contained on
a vehicle in a policy. Annually, the department sends close to one million suspension notices to
customers for the purpose of verifying insurance. Sixty percent of our case types (this means some
event occurred) require the customer to provide us the levels of insurance to ensure they meet Financial
Responsibility requirements. Reporting this threshold in advance, would eliminate a SR-21 verification,
prevent customer calls to your company, and provide better overall customer service to our mutual
customers.

Vehicles registered as ‘Commercial Motor Vehicles’ as described in s. 320.01(26), are required to have
certain levels of coverage as described in section 627.7415 and these levels must be verified by Florida
Driver License/Tax Collector Offices at time of registration, per statute. Currently, our mutual customers
provide this information via a paper document (COIl). If these levels were reported through the
insurance database, it would eliminate the need for manual verification and allow these customers to
utilize on-line services thus freeing up the lines in offices across the state. This level of coverage should
have a corresponding value (shown below) of ‘01’ thru ‘08’.
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Field Value Definition

01 PIP/PDL 627-7275 324.0221 324.0222
Minimum coverage is $10,000 personal injury protection (PIP) and $10,000 property
damage liability (PDL)

02 BI/PDL 10/20/10 Basic Bl 324.021

Minimum limits of bodily injury liability of $10,000 per person, $20,000 per crash,
$10,000 property damage liability per crash, and PIP limits of $10,000 per person per
crash

03 BIL/PDL 100/300/50 DUI 324.023

Minimum limits of bodily injury liability of $100,000 per person, $300,000 per crash,
$50,000 property damage liability per crash, and PIP limits of $10,000 per person per
crash

04 BIL/PDL Commercial 627.7415 50 CSL (in addition to 10k PIP)
Minimum limits of Bodily Injury Liability and S 50,000 Combined Single Limits (CSL), and
PIP limits of $10,000 per person per crash (For Vehicles > 26k Ibs)

05 BIL/PDL Commercial 627.7415 100 CSL (in addition to 10k PIP)
Minimum limits of Bodily Injury Liability and $100,000 Combined Single Limits (CSL), and
PIP limits of $10,000 per person per crash (For Vehicles > 35k Ibs)

06 BIL/PDL Commercial 627.7415 300 CSL (in addition to 10k PIP)
Minimum limits of Bodily Injury Liability and $300,000 Combined Single Limits (CSL), and
PIP limits of $10,000 per person per crash (For Vehicles > 44k Ibs)

07 BIL/PDL Commercial 627.7415 750 CSL (in addition to 10k PIP)
minimum limits of Bodily Injury Liability and $750,000 Combined Single Limits (CSL), and
PIP limits of $10,000 per person per crash (For Hazardous Materials)

08 Taxi BIL/PDL -125/250/50 324.032/627.7415

minimum limits of bodily injury liability of $125,000 per person, $250,000 per crash,
$50,000 property damage liability per crash, and PIP limits of $10,000 per person per
crash (For Taxi Cabs)

Policy Through Date

The Policy Through Date field is a new, optional field used to describe the expiration date of the policy.
In the future, this field will be used to identify when a policy is no longer valid. At this time, a
transaction type ‘10’ cancellation of insurance (or non-renewal) will still need to be reported to our
department. Until further notice, the through date is not being used but is there for future functionality.
Again, if you decide to use the through date, once the through date is reached and you are not sending a
renewal, you must send a cancellation (transaction type ‘10’).

Insurance Company Notes

The ‘Insurance Company Notes’ field is a new, optional field used to by the insurance companies. This
field will be returned with error files.
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Policyholder Date of Birth

The ‘Policy Holder Date of Birth’ field is a new, optional field. If you do not have a Florida Driver License
Number then the Policy Holder Date of Birth is one of the three fields that are required to generate a
driver’s license number.

Policyholder Gender

The ‘Policy Holder Gender’ field is a new, optional field. If you do not have a Florida Driver License
Number then the Policy Holder Gender is one of the three fields that are required to generate a driver’s
license number.

Effective Date of the Policy Holder

The ‘Effective Date of the Policy Holder’ field is a new, optional field used to describe the date the driver
was added to the policy. In a reload file, the PH Effective Date is optional (if a ‘34’ is not used) and will
be defaulted to the Policy Effective Date if left blank. However, during a Daily Load, the Policy Holder
Effective Date for a ‘34’ transaction type will be required.

Effective Date of the Vehicle

The ‘Effective Date of the Vehicle’ field is a new, optional field used to describe the date the car was
added to the policy. In a reload file, the Vehicle Effective Date is optional (if a ‘31" is not used) and will
be defaulted to the Policy Effective Date if left blank. However, during a Daily Load, the Vehicle Effective
Date for a ‘31’ transaction type will be required.

Note: More details regarding these fields and existing fields are in the next section.

Note: The below applies for both policy holders and vehicles. There is more information concerning
Daily files in the Daily Manual.

e Inareload, if you have multiple policy holders and the policy holder effective
date is the same as the policy effective date then all information will be under
the ‘20’ in position 2a.

e Inareload, if you have multiple policy holders and the policy holder effective
date is different than the policy effective date then a ‘20’ will be in position 2a
and a ‘34’ with the policy holder effective date will be needed for any policy
holder with a different effective date
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Filing Record Layout

ltem No | Node or | Field Name Character type Required Length | Comments
Element Optional
Conditional
1 N Insurance Company R Unbounded
la E FL Company Code Numeric R 5
2 N Transaction R Unbounded
2a E Transaction Type Numeric R 2
3 N Policy R Unbounded
3a E Insurance Policy Number Alphanum R 30
3b E Policy Effective Date Date R 8 MMDDCCYY
3c E Policy Through Date Date 0] 8 MMDDCCYY
3d E Insurance Company Notes | Alphanum 0] 50
4 N Policy Holder R Unbounded
4a E Company Indicator Alpha R 1 YorN
4b E PH First Name Alpha C 16
4c E PH Middle Name Alpha 0] 16
4d E PH Last Name Alpha C 20
de E PH Name Suffix Alpha 0] 3
4f E PH Gender Alpha 0] 1 M or F or Blank
4g E PH DOB Date 0] 8 MMDDCCYY
4h E PH Street Address Alphanum 0] 30
4i E PH City Alpha 0] 20
4j E PH State Alpha 0] 2
4k E PH Zip Numeric 0] 9
41 E FL DL Number Alphanum 0] 13
4dm E FEID Numeric 0 9
4n E PH Non-Structured name | Alphanum C 50
40 E PH Transaction Type Numeric C 2
4p E Effective date of the PH Date C 8 MMDDCCYY
4q E FR Case Number Alphanum C 9
4r E FR Certification Date Date C 8 MMDDCCYY
4s E FR Prepared Date Date C 8 MMDDCCYY
5
5a E Fleet Indicator Alpha R 1 YorN
5b E VIN Alphanum C 21
5c E Vehicle Year Numeric C 4 CCYY
5d E Make Alphanum C 5
Se E Effective date of the Date 0] 8 MMDDCCYY
vehicle
5f E Level of Coverage Numeric ] 2 01-08
5g E Vehicle Transaction Type Numeric C 2
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6a E Tracking Number Provided by C 36
HSMV
(Alphanum)
6b E Required Coverage Date Provided by C 8 MMDDCCYY
HSMV (Date)
6¢ E Status Message Provided by C 50
HSMV
(Alphanum)
6d E Days Late Provided by C 3 le. 040
HSMV (Numeric)
6e E Yes Confirmed and Active | Alpha C 1 YorN
6f E Confirmed Alpha C 1 YorN
6g E Unconfirmed Alpha C 1 YorN

Conditional Field Applicability:
Transaction Type (2a): For transaction types: 10, 11, 13, 20, 21, 22, 26, 30, 33, 36, 44 and 46 this field
will be used. This field can also be used for transaction types 31, 32, 34 and 35 if no other transactions

are being performed on the same transaction.

PH Last Name (4d): If Company Indicator = ‘N’, then the PH’s last name is required. A hard error
message will be received, if the Last Name is missing.

FEID (4m): If Company Indicator = ‘Y’, then the FEID is optional. A warning message will be received, if
the FEID is missing.

PH Non-Structured Name (4n): If Company Indicator = ‘Y’, then the PH Non-Structured Name is

required. A hard error message will be received, if the PH Non-Structured Name is missing.

PH Transaction Type (40): If used on a reload, there are two possible scenarios:

1. A ‘20’ needs to be in position 2a and a ‘34’ needs to be in position 4p. This is used to show a
driver/PH has not been on the policy since the policy effective date.

2. A ‘34’ can be in position 2a if there is a ‘20’ transaction with the same policy number above the
34’ in the reload file.

Effective Date of PH (4p): During a reload, the Effective Date of a Policy Holder is only applicable if a ‘34’

was submitted with a 20’ (in position 2a).

FR Case Number (4q): Not applicable to a reload but required when submitting SR-22s and FR-44s.

More details are to follow.
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FR Certification Date (4r): Not applicable to a reload but required when submitting SR-22s and FR-44s.

More details are to follow.

FR Prepared Date (4s): Not applicable to a reload but required when submitting SR-22s and FR-44s.

More details are to follow.

VIN (5b): If Fleet Indicator = ‘N’, then the VIN is required. A hard error message will be received, if the
VIN is missing.

Vehicle Year (5c): If a VIN is present, then the Vehicle Year is required. A hard error message will be
received, if the Vehicle Year is missing.

Make (5d): If a VIN is present, then the Make is required. A hard error message will be received, if the
Make is missing.

Vehicle Effective Date (5e): During a reload, the Effective Date of a Policy Holder is only applicable if a

‘31’ was submitted with a ‘20’ (in position 2a).

Vehicle Transaction Type (5g): If used on a reload, there are two possible scenarios:

1. A ‘20’ needs to be in position 2a and a ‘31’ needs to be in position 5g. This is used to show a
vehicle has not been on the policy since the policy effective date.

2. A ‘31’ can bein position 2a if there is a ‘20’ transaction with the same policy number above the
31" in the reload file.

Note: Transaction type (2a) should never be left blank.

Tracking Number (6a): Only used for Verification requests, transaction type ‘12’. When a transaction

type 12 (SR21 verification request) is sent to your insurance company, it will contain a tracking
number. Please do not modify any of the supplied data.

Required Coverage Date (6b): Only used for Verification requests, transaction type ‘12’. When a

transaction type 12 (SR21 verification request) is sent to your insurance company, it will contain the
required coverage date. The required coverage date should not be altered.

Status Message (6¢): Only used for Verification requests, transaction type ‘12’. When a transaction type
12 (SR21 verification request) is sent to your insurance company, it will contain a specific status
message, which will be provided in the near future. The status message should not be altered.

Days Late (6d): Only used for Verification requests, transaction type ‘12’. When a transaction type 12
(SR21 verification request) is sent to your insurance company, you have 30 days to respond. If after 30
days we have not received a response, we will continue to resend the SR-21 every 30 days. In the Days
Late field, you will be provided with the number of days that have passed since the original date that the
SR21 was sent.
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Confirmed and Active (6e): Only used for Verification requests, transaction type ‘12’. When set to ‘Y’,

this means that the driver had coverage with your insurance company on the SR21 Required Coverage
Date and is still active today. This record will be treated as a ‘20’ type transaction.

Confirmed (6f): Only used for Verification requests, transaction type ‘12’. When set to ‘Y’, this means
that the driver did have coverage with you on the SR21 Required Coverage Date.

Unconfirmed (6g): Only used for Verification requests, transaction type ‘12’. When set to ‘Y’, this
means that the driver did not have coverage with you on the SR21 Required Coverage Date and
currently does not have a valid policy.

NOTE: When responding, must have only one (6e, 6f, 6g, 6h) set to ‘Y’ and the others set to ‘N’.

Additional Information:

Multiple Company Codes

For each file, companies can submit for multiple FL Company codes as you have done in the past. For
each FL Company code that is identified, companies can submit multiple transactions. For each
transaction, companies can submit the policy information. Within the policy node, companies can
include all policy holders and vehicles associated with policy.

Out of State Driver’s License Numbers

If the driver’s license is out of state or country, please leave the Driver’s License field blank, so you will
not receive any errors. If you do have a Florida’s Driver’s License, please provide us with the
information.

Accepted Special Characters

There are a few errors that reference “invalid characters”, the acceptable special characters are a space,
a hyphen (-) or an apostrophe (‘).

Adding Drivers and Vehicles

An example when a ‘31’ can be used for a reload, “If you have a policy that has been in effect with you
since 10/01/2011 and they had one vehicle on that policy. Then in February, they added a second
vehicle to the policy. If you wanted to show that the new car has not been on that policy since the
policy effective date, you would use a ‘31’ transaction type. A ‘20’ would be in position 2a and then in
the vehicle section, you would have the original vehicle listed. In order to report the new vehicle, you
would have a second vehicle section with a transaction type ‘31’ in position 5g with a different vehicle
effective date (5e).

For a Daily submission, you can submit your Add and Deletes individually or you can have multiple
transactions. If you are submitting them individually, you will use transaction type (2a). If you are
adding a vehicle and driver, you would put a ‘34’ in the transaction type (2a) and a ‘31’ in the Vehicle
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Transaction Type (5g). Or if you wanted to only add a driver to an existing policy, you would put a 34’ in
the Transaction Type (2a) field.

IMPORTANT: Transaction Type (2a) should never be left blank.

Empty XML Fields

In XML, an empty element or an empty space may be submitted. Please see example below.
For example, if the policy does not have an FEID number, either will work:

<FEID/> OR

<FEID></FEID> OR

<FEID> </FEID>

Transaction Types
For reload purposes, the Transaction types accepted are:

20 Initiation of Insurance
31  Add Vehicle to Policy

34  Add Policy Holder to Policy

Steps to validate a XML file (Reload or Daily) against the XSD file

First, you will need an XML tool. The free tool we use here is Notepad ++. You can download it
at: http://notepad-plus-plus.org/ . Once installed, on the file menu, go to ‘Plugins’ > ‘Plugin
Manager’ > ‘Show Plugin Manager’ and install ‘XML Tools’.

1. Download the following file from http://www.flhsmv.gov/FRManualFTP/

. ‘FLBOB_Template_Reload_and_Daily_Inputs.xsd’. Or if you are having issues
downloading the file, please request it to be emailed to you by contacting
FLHSMVInsuranceliaison@flhsmv.gov .

2. Open the XML tool, if you are using Notepad ++, on the File menu, go to ‘Plugins’ >
‘XML Tools’ > ‘Validate Now’. Browse to the location of the
‘FLBOB_Template_Reload_and_Daily_Inputs.xsd’ file.

3. Click “OK” to validate.

You will either receive an “INFORMATION” window with your errors or a message stating your

file validated successfully. If you have errors, correct the errors and then re-validate your
file. Repeat until you receive the successful validation message.
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